
Studio Toolkit for Flexibles

User Guide



Studio Toolkit for Flexibles

ii

Contents

1. Copyright Notice.......................................................................................................................................................................... 3

2. Introduction.....................................................................................................................................................................................5

2.1 About Studio....................................................................................................................................................................... 5

2.2 Workflow and Concepts................................................................................................................................................. 6

2.3 Quick-Start Tutorial...........................................................................................................................................................7

3. Creating a New Bag.................................................................................................................................................................11

3.1 Pillow Bags........................................................................................................................................................................11

3.1.1 Panel Order and Fin vs. Lap Seals.............................................................................................................13

3.2 Gusseted Bags.................................................................................................................................................................14

3.2.1 Open or Closed Gussets................................................................................................................................ 14

3.3 Stand-up Pouches..........................................................................................................................................................15

3.3.1 Stand-Up Pouch without Bottom Seal......................................................................................................16

3.4 Quattro Seal Bags.......................................................................................................................................................... 17

3.4.1 Seals for Quattro Seal Bags..........................................................................................................................18

3.5 Sachets................................................................................................................................................................................20

3.5.1 Sachet Type and Orientation.........................................................................................................................22

3.6 Diaper Bags.......................................................................................................................................................................24

4. Live Shaping................................................................................................................................................................................26

4.1 Starting and Stopping Live Shaping....................................................................................................................... 26

4.2 Live Shaping and Done/Stalled.................................................................................................................................26

4.3 Air and Liquid Content................................................................................................................................................. 27

4.4 Making the Shape Smooth or Wrinkly................................................................................................................... 28

4.4.1 Setting the Stiffness Value............................................................................................................................. 28

4.5 Working with Pullers...................................................................................................................................................... 28

4.5.1 Creating and Changing Pullers.....................................................................................................................28

4.5.2 Deleting Pullers................................................................................................................................................... 28

5. Using the Studio Toolkit application................................................................................................................................ 29

5.1 Saving and opening Collada files.............................................................................................................................30

5.2 Import Into......................................................................................................................................................................... 30

5.2.1 Obtain a 3D file for a container....................................................................................................................30

5.2.2 Using graphic files............................................................................................................................................. 31

5.3 Move and Rotate............................................................................................................................................................ 32

5.4 Repeat................................................................................................................................................................................. 35

5.5 Tabs...................................................................................................................................................................................... 36

5.6 Preferences........................................................................................................................................................................36



1
Studio Toolkit for Flexibles

3

1. Copyright Notice

© Copyright 2012 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BVBA. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BVBA does not warrant, guarantee or make any representations
regarding the use, or the results of the use of the software or the information contained herein. Esko
Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising
out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published,
in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other
means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other
trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly
owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2012. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.
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The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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2. Introduction

Important note

The Studio Toolkit application is a standalone application allowing to import, edit and create 3D
objects, and save the object(s) as Collada file.

Eventually, it will replace the "Studio Toolkit for Flexibles" application. However, this first version of
Studio Toolkit does not contain all functions and possibilities the Studio Toolkit for Flexibles has.
Therefore Studio Toolkit for Flexibles is still included in this release.

For basic flexible packaging, you can use the Studio Toolkit application, but for more complex bag
creations, you can still use Studio Toolkit for Flexibles.

Note:  If you want to use a bag created in Studio Toolkit for Flexibles into the Studio Toolkit application
(e.g. to create a repeat or a combination of different objects), you need to keep in mind that this
version of Studio Toolkit only imports Collada files, while Studio Toolkit for Flexibles exports .bag
files. You can however open a bag file in Studio Designer, and save it as a collada file there.

2.1 About Studio

Studio is a unique set of tools for 3D packaging design made specifically for packaging artwork
professionals.

Working in 3D for packaging typically consists of 3 steps: first you create a shape or "structure".
Next you apply artwork to that shape. And finally you present the result as an image, movie, etc.

To achieve this, Studio has different modules (shown as purple rectangles in the image underneath).
It takes you through different software applications, such as Adobe Illustrator and the Studio Toolkit.
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Step 1: Create a Structure

The first step is to prepare a 3D packaging shape, with a matching 2D key line template. This shape
can come from one of the Studio Toolkits, from ArtiosCAD or from Esko's Shape server.

The Studio Toolkits allow to create or modify structural design files for a specific use or workflow.
Every Studio Toolkit consists of an Adobe Illustrator plugin and/or specific functionality inside the
Studio Toolkit application. The Studio Toolkit application allows to import, create, modify or combine
shapes, and save the result as a collada file.

• With the Studio Toolkit for Boxes plugin you can clean up die-drawings of boxes, and fold them
into a 3D shape.

• You can use the Studio Toolkit for Flexibles functions in the Studio Toolkit application to create
3D models of flexible packaging.

• With the Studio Toolkit for Labels plugin, you can create round objects with one or more labels,
and automatically warp artwork for conical labels. With the Studio Toolkit for Labels functions in
the Studio Toolkit applications, you can draw labels on existing shapes.

• With Studio Toolkit for Shrink Sleeves in the Studio Toolkit application you can create a heat
shrink sleeve around one or more shapes, and simulate the distortion. Using the Studio Toolkit
for Shrink Sleeves plugin, you can apply counter distortion to your artwork.

Step 2: Apply Artwork

The second step is to make sure the production artwork fits to the structure.

In Adobe Illustrator, ArtPro or PackEdge, you can use Studio Designer to get a preview of the 3D
object with its artwork, check every detail, and fix specific issues.

With Studio Visualiser you can simulate print substrates and a wide range of print and finishing
effects.

Step 3: Share

You can share your 3D design using the Studio Viewer or Webcenter, or use your 3D design in Store
Visualizer.

In Studio Designer and Visualiser, you can export your 3D designs to share realistic virtual packaging
mock-ups as movies, images or interactive 3D.

2.2 Workflow and Concepts

About Studio Toolkit for Flexibles

Studio Toolkit is an application that runs on Mac OS or on Windows, and allows you to design and
create flexible packages like potato chips bags, candy bar wrappers, stand-up pouches and diaper
bags, to name but a few of the many possibilities.

The design will be saved to a Collada file, and this file can then be imported in Adobe® Illustrator®,
or in specialized Esko editors such as ArtPro, PackEdge or Visualizer.

Using the collada file in Studio Designer

Once a .bag file is placed in an Illustrator, ArtPro or PackEdge document, the Studio window can
display a three-dimensional preview of the packaging with the Illustrator/ArtPro/PackEdge artwork
rendered on it. This allows you to see how the graphics will look on the final bag. Studio also contains
productive tools for quick and accurate aligning.
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With Studio you can export the 3D design to various file formats such as 3D PDF for interactive
viewing or a TIFF rendering to use in ads.

Using the collada file in Visualizer

Placing the Collada file in Visualizer allows you to render special finishes, such as foils or varnishes
on the 3D design. The rendered images can be exported to QuickTime movies or to a wide variety
of image formats that can be used in advertising.

2.3 Quick-Start Tutorial

As an introduction exercise, we will explain how you can make a 3D PDF of a simple pillow
bag. We assume you have Studio Toolkit for Flexibles , Adobe Illustrator and Studio for
Adobe Illustrator installed.

1. Start Studio Toolkit.
2.

Click the New Bag button 
3. Select the Pillow Bag type and click OK.

A bag will be shown in 3D, using the default dimensions, and some basic Live shaping is applied.
The Bag tab contains the 2D foldout layout of the pillow.

4. You can apply Live Shaping but we will skip this step for now. Click  File  > Save   and save
the bag as a Collada file.
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5. Start Adobe® Illustrator® and open the saved file. If you have the latest version of Studio installed,
you can open the files in Illustrator. Illustrator will show you a document with a locked layer that
contains the keylines. This is the foldout layout of the pillow bag that we just made. The biggest
rectangle in the center is the front face of the bag.

6. Open the Studio Window: Choose  Window  > Esko  > Studio Designer > Show Studio . The bag
shape created in Studio Toolkit will appear. Click and drag the mouse to rotate it. Use Adobe®
Illustrator® to create the graphic artwork for the bag.

7. Click the update button in the bottom left corner of the Studio Window to render the graphics
preview on top of the 3D visualization of your bag or choose  Window  > Esko  > Studio Designer
> Refresh Studio  .

The shortcut key to activate the tool is  Cmd+Option+6   or  Ctrl+Alt+6  .
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Tip:

Click the fly-out menu button to gain quick access to important functionality such as exporting
to 3D PDF.

8. On the fly-out menu, choose Export... .

9. Choose PDF File with 3D Design  as file type and click Save As…

10.After exporting, open the resulting PDF file in Adobe® Reader® 8 or Adobe® Acrobat® and use
the 3D tools to rotate, zoom,...
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3. Creating a New Bag

1.

Click the New Bag  button  to create a new flexible bag.

2. Select a bag type and click Ok .

A bag of the selected type will be created, using default settings. A 2D tab containing the 2D
die is added.

If the bag is selected, all parameters can be changed in the right panel.

Note:

When creating or changing a bag, some initial Live Shaping will be applied to the 3D bag.

3.1 Pillow Bags

A pillow bag is a simple flexible bag with a top and bottom seal, and a centered or off-center vertical
backseal. The most common examples of pillow bags are potato chips bags and certain candy bar
wrappers.



3
Studio Toolkit for Flexibles

12



3
Studio Toolkit for Flexibles

13

Settings:

• Dimensions: Width, Length Top Seal and Bottom Seal
• Back Seal: Size, Type (Fin Seal or Lap Seal), Order, and Position. See Panel Order and Fin vs.

Lap Seals on page 13

3.1.1 Panel Order and Fin vs. Lap Seals

A back seal can be folded ( Fin Seal ) or glued ( Lap Seal ) to the back side of the package in two
ways: Left over Right  or Right over Left . Depending on the selection, the image of the seal will
be adjusted.

For gusseted and pillow bags, you can specify the Position  of the back seal: select Centered  to
center the back seal on the back panel, or disable Centered  and provide an offset value in the field
below that option.

Note:

The offset value in the Position field is the width of the left or right back flap, whichever is on top as
specified in the Order  list ( Left over Right  or Right over Left ). In other words, if the Order is set to
Left over Right, the Position value you type is the width of the Left back flap.
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3.2 Gusseted Bags

A gusseted bag is a more complex flexible bag with top, bottom and back seals and gussets at
both sides. The gussets allow the bag to make a more block-like shape. Just like pillow bags, Studio
Toolkit supports back seals that are either centered or off-center at the back. For gusseted bags,
you can also choose whether you want an open or a closed (glued) gusset.

Settings:

• Dimensions: Width, Length, depth
• Seals: Top Seal & Bottom Seal, Open or Closed Gusset. See Open or Closed Gussets on page

14
• Back Seal: Size, Type (Fin Seal or Lap Seal), Order, and Position. See Panel Order and Fin vs.

Lap Seals on page 13

3.2.1 Open or Closed Gussets

For gusseted and quattro seal bags, you can specify whether you want to have Open Gussets  for
the top and/or bottom gussets.
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Note:  For pouches you can only choose to have open or closed bottom gussets.

3.3 Stand-up Pouches

A stand-up pouch is a flexible bag with top, left, right and optional bottom seals, with a gusset in the
bottom part but not in the top part. You can specify an open or a closed (glued) gusset.

Currently, only pouches in one piece are supported, meaning that the bottom is part of the complete
package. Studio Toolkit for Flexibles  only supports rectangular pouches.

Tip:

You can also create a pouch without bottom seals. Simply set the bottom seal value to 0mm/inches.
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Settings:

• Dimensions: Width, Length, depth
• Seals: Top Seal, Bottom Seal and Side Seal. Open or Closed Gusset. See Open or Closed Gussets

on page 14

3.3.1 Stand-Up Pouch without Bottom Seal

You can create a stand-up pouch with no bottom seal by setting the Bottom Seal  value to 0mm/inch.
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3.4 Quattro Seal Bags

Like the gusseted bag, the quattro seal bag is a complex flexible bag with top and bottom seal and
gussets at both sides. The gussets can be open (unglued) or closed (glued) near the top and/or
bottom seals.

Different from the gusseted bag, the quattro seal bag also has four vertical side seals . Studio
Toolkit also supports the version without any side seals: simply set the side seals value in the
application to 0mm/inch.

Common for a quattro seal bag is the fact that the (back) seal is "hidden" in one of the four corners
of the bag. A quattro seal bag can have a tapered or square bottom and/or top. This bag type is
commonly used for products such as coffee pads, cookies and animal food.
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Settings:

• Dimensions: Width, Length, depth
• Seals: Top Seal, Bottom Seal and Side Seal, Open or Closed Gusset. See Open or Closed Gussets

on page 14.
• The Join position: see Seals for Quattro Seal Bags on page 18
• Style: Tapered or Square. See Seals for Quattro Seal Bags on page 18

3.4.1 Seals for Quattro Seal Bags

You can create a quattro seal bag without side seals  by setting the Side Seals  value to 0 mm/inch
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The Back Seal  for quattro seal bags is hidden in one of the four corners of the bag. The Join  setting
in Studio Toolkit for Flexibles  allows you to specify whether the back seal is hidden in the back left
or the back right corner of the bag.

Quattro seal bags can have a tapered or square top and/or bottom .
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3.5 Sachets

A sachet is a simple flexible bag type with three seals and a fold, or with four seals:
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• For three-seal sachets, Studio Toolkit lets you choose whether the fold is at the top, right, bottom,
or left side of the sachet.

• For four-seal sachets, you can only change the orientation of the die shape, either horizontally
aligned front and back or vertically.

The sachet bag type is commonly used for powder products like dried herbal mixes, instant soup,
baking powders,...

A four-seal sachet, sealed along the four sides:

A three-seal sachet with a fold at the bottom and seals along the left, right and top sides:
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Settings:

• Dimensions: Width, Length
• Type and Orientation. See Sachet Type and Orientation on page 22
• Seals: Top & Bottom Seal, Left & Right Seal

3.5.1 Sachet Type and Orientation

Studio Toolkit for Flexibles  supports both three-seal sachets with a fold and three seals, and four-
seal sachets.

If you have specified a three-seal sachet with a fold, Studio Toolkit for Flexibles  allows you to choose
where you want the fold to appear (left, right, top or bottom).
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If you chose a sachet with four seals, the orientation has no effect on the 3D representation, because
there is no fold. However, it applies to the layout of front and back of the 2D die: either front and
back will be joined vertically or horizontally.
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3.6 Diaper Bags

The diaper bag is a very complex flexible bag type. A diaper bag has a bottom seal, side gussets
at the bottom (horizontal gussets at the bottom) and top gussets at the top (vertical gussets at the
top) of the bag.

Diaper bags are commonly used for diapers, sanitary napkins, ....

Note:

Certain variants of the diaper bag die shape may not be supported by Studio Toolkit.
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Settings:

• Dimensions: Width, Length, depth
• Bottom Seal.
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4. Live Shaping

When you interact with a real bag, it responds instantly. When you interact with a virtual bag in Studio
Toolkit, your computer has to perform heavy calculations to find a new realistic looking shape. This
could take a long time to complete. Instead of waiting for every shaping operation to be finished
completely, Studio Toolkit shows the shaping process live and offers you the possibility to keep on
interacting, even while it is still shaping. This is called Live Shaping . If computers were infinitely
powerful, Live Shaping would be obsolete.

You do not have to wait for Live Shaping to finish. Simply interact with the shape, wait and see how
Live Shaping reacts and as soon as you are happy with the result, you save it.

4.1 Starting and Stopping Live Shaping

When creating a new bag, a small amount of live shaping is applied to it automatically. To
start the Live Shaping process, click the Live Shaping  button.

At any time you can decide to stop Live Shaping. Just click the Done  button. The shape
will pause in its current state. To continue Live Shaping, click the Live Shaping  button in
the Document Window.

Using the Pauze / Resume button, you can also temporarily pauze the Live Shaping.

Note:

After Live Shaping, you can no longer change the dimensions or other parameters of the
bag. By clicking Restore Shape you can undo the live shaping and make changes to the
parameters possible. After that, you can redo the Live Shaping.

Note:  If you Undo during live shaping, Studio Toolkit will first stop the live shaping (same
as clicking the "Done" button) before undoing it. This way, you can use Redo to return to
the point before the Undo

4.2 Live Shaping and Done/Stalled

When a certain bag has reached its final form, Live Shaping will indicate this by displaying Done .
The bag will start shaping again when needed, for example when adding some more air. If for some
reason the bag does not Live Shape anymore but still has not reached its final form yet, Live Shaping
will display Stalled . In this case it is best to save the file and send it to your Esko contact person for
further investigation. It is definitely not an intended state of Live Shaping.
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Note that you do not have to wait until Live Shaping stops. You can stop it as soon as you find it
reached a pleasing form and save the file.

Note:  In some cases, putting the stiffness slider to zero unstalls the file.

4.3 Air and Liquid Content

When you create a new document of any of the three different packaging types, the bag will
automatically start to fill up with air. You can compare this with a bag that is not completely airtight.
It will not stop air from moving in or out of the bag. In the Shape  section of the Window, the blue air
bar will give you an indication of the actual amount of air that is currently in the bag.

You can take control over the amount of air that is put into the bag by checking the Air  box. When
checked, you actually simulate an airtight bag. Use the slider to specify how much air should be
put inside the bag. As Live Shaping might need some time to catch up with the new conditions, the
actual content (the blue bar) might lag behind a little.

Note:  If you move the slider too much to the right, you might put an exaggerated amount of air in
the bag and make it look overstretched.

Next to air, Studio Toolkit for Flexibles  also allows you to add Liquid . The difference between air
and liquid lies in their respective weights. As liquid is heavier than air, the liquid will be concentrated
in the lower part of the package. During Live Shaping, a bag that is filled with liquid will gradually
fall down until it eventually lies on the floor.

Adding liquid is also a convenient way to simulate the shape of bags that contain bulky materials
such as frozen vegetables or meatballs. If you add liquid while the Air  box is checked, the total
volume of the bag will increase. If you add liquid while the Air box is not checked, part of the air in
the bag is simply replaced by liquid.
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Note:  The gravity effect when adding liquid is visualized quite slowly with Live Shaping. Temporarily
reducing Stiffness  might speed it up.

4.4 Making the Shape Smooth or Wrinkly

There are several ways to make a package look more wrinkly or more smooth.

4.4.1 Setting the Stiffness Value

The Stiffness  of the package can be manipulated by moving the slider in the Shape section of the
Control Window. The higher the stiffness, the more the substrate will try to straighten itself. The lower
the stiffness, the easier the package will 'collapse', as if it were made from a soft, thin foil.

Altering the stiffness has a direct impact on Live Shaping. The resulting shape will be re-calculated
and the amount of air and liquid will be added or subtracted accordingly.

4.5 Working with Pullers

The Puller  tool  allows you to interactively change the shape of the package by creating pullers.
A puller grabs a point on the package and pulls it in the desired direction. Pullers look like small
needles. One end of a puller is attached to the bag, the other end is a target position fixed in space.
A puller will pull the attached point on the surface of the bag towards the target position.

4.5.1 Creating and Changing Pullers

To use pullers, first make sure you are in the 3D View. Activate the Pullers tool. Since pullers
interact with Live Shaping it is often most convenient to first pause Live Shaping too.

To create a new puller, just hold the left mouse button when the cursor is somewhere on the
bag. This will create a puller that is attached to that point on the bag. The other end of the
puller can now be moved by dragging the mouse while holding down the mouse button.

4.5.2 Deleting Pullers

You can click the Delete all pullers button to remove all pullers from the bag.
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5. Using the Studio Toolkit application

The Studio Toolkit application is a standalone application allowing to import, edit and create 3D
objects, and save the object(s) as Collada file.

1. The Zoom buttons, allowing to change the zoom factor of the preview window. You can click and
drag to rotate the view.

2. Import Into allows to import 3D or image files. See Import Into on page 30
3. The New Bag tool, used in Studio Toolkit for Flexibles
4. The Add Sleeve tool, used in Studio Toolkit for Shrink sleeves
5. The Add Label tool, used in Studio Toolkit for Labels
6. The Move and Rotate tool. See Move and Rotate on page 32
7. The Repeat button. See Repeat on page 35
8. The Settings pannel, allowing to change or view the parameters on the selected object
9. the Preview panel
10.The different Tabs. See Tabs on page 36
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11.When performing some specific functions (such as Move and Rotate, ...), a settings bar is added
underneath the Toolbar.

5.1 Saving and opening Collada files

When saving a file from Studio Toolkit, the file is saved as a Collada file, containing the shape and
all printable parts.

This means the file can be opened by any application that is capable of handling Collada files, such
as Studio Designer.

However, the Collada files saved by Studio Toolkit also contains native Studio Toolkit information,
allowing to reopen the file in Studio Toolkit, maintaining its editability, the active tab, zoom and view
factor, etc.

Note:  When dropping a Collada file onto the Studio Toolkit application, Studio Toolkit will determine
if it is a Collada file saved in Studio Toolkit or not. A native Studio Toolkit Collada file will be opened,
a regular Collada file will be imported.

5.2 Import Into

Using the Import Into button  you can import a 3D shape into your open scene.
If you already have a 3D object in your scene, the newly imported 3D shape will be placed next to it.

For more info on how to obtain a 3D file, see Obtain a 3D file for a container on page 30

When importing a Collada file, any printable parts from this file will be preserved when saving to a
Collada file.

Note:  Collada files saved by Studio Toolkit can also be opened instead of imported. In that case,
the file will be reopened as it was saved, with the same active tab, zoom and view, and maintaining
full editability. See Saving and opening Collada files on page 30

You can also use the Import Into button to import an image (JPG or PNG) in a 2D tab (e.g. the
"Sleeve" tab), to get a preview of this image on the corresponding 3D object. See Using graphic
files on page 31

Note:  Studio Toolkit can not import .bag files. If you need to compose flexible bags or boxes saved
as .bag files, we suggest you convert these to Collada files in Studio Designer first.

5.2.1 Obtain a 3D file for a container

There are several ways to obtain a 3D file :
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• You can get a shape on Esko's online Shapes store
• You could hire a 3D artist to make the shape with a 3D modeling tool, such as Cinema 4D, 3DS

Max, Maya or Strata. If you are experienced with these tools, you could do it yourself.
• Contact the mold-designer and ask him for a Collada or OBJ file of the container.
• If you have a physical sample of the object, you can use a tabletop 3D laser scanner. See

www.nextengine.com for an example of such a scanner. This device can output .obj files.
• If the object is a round shape, you can use Studio Toolkit for Labels to create it yourself. For more

information, we refer to the Studio Toolkit for Labels documentation.

The format needs to be collada (.zae or .dae) or .obj. Collada stands for COLLAborative Design
Activity for establishing an interchange file format for interactive 3D applications) These 3D files do
not need a printable part at this stage, you will add that yourself in the next step.

5.2.2 Using graphic files

In Studio Toolkit you can import graphic files to get a preview of the result, and to assist in positioning
e.g. the overlap. You can also use it to place a technical drawing on the sleeve.

Using the Import Into button  you can import an RGB JPEG or PNG file.

• If a 2D tab is selected, the image will be imported in that tab
• If an object is selected in the 3D tab, the image will be imported in the corresponding 2D tab,

and this 2D tab will become active

By default, the image will be aligned with the bottom left corner of the image on the bottom left corner
of the printable part. You can move the graphic by clicking and dragging the border. The border
(left, right, top or bottom) or corner you clicked, will become magnetic, and snap to the borders and
folding lines of the 2D shape, allowing easy alignment.

This magnetism is shown using a thick blue line.

The 3D tab will show a 3D representation of the file with the corresponding graphics on it.



5
Studio Toolkit for Flexibles

32

5.3 Move and Rotate

Since you are working in a 3D environment, you can move and rotate any object based on 3 axis.
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If the Move and Rotate tool is selected, you can select one of three modes in the settings bar:

•

 Simple Move and Rotate

• Click and drag the center anchorpoint or change the Offset X and Z value to move the object
over the X and Z axis. Holding down the shift while dragging will constrain the movement to
either only along the X or Z axis.

• Click and drag the anchor point on the circle or change the Rotation value to rotate the object
on the Y axis. Holding down the shift while dragging will constrain rotation to multiples of 45
degrees.
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• Simple Move and Rotate keeps the object aligned with the floor. However, by setting the
Distance from Floor option in the settings bar, you can also move the object over the Y axis,.

•

 Move only

• Click and drag any of the anchorpoints or change the Offset X, Y or Z value to move the object
over the X, Y and Z axis.

•

 Rotate only

• Click and drag any of the anchorpoints or change the Rotate X, Y or Z value to rotate the
object over the X, Y and Z axis. Holding down the shift while dragging will constrain rotation
to multiples of 45 degrees.
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Tip:  After rotating, you might need to align the object with the floor again. You can do so by
switching to Simple Move and Rotate, and set the Distance from floor to zero.

If you click and drag but not on any of the anchor points, you will change the camera position, but
the object will NOT move. This might be necessary to make all handles visible.

Note:  When moving or rotating a 3D shape, the depending parts (sleeves and labels) are moved /
rotated along.

5.4 Repeat

Using the Repeat button, you can create a simple repeat of the selected

object(s).

• Enter the number of repeats you want along the X, Z and Y axis
• Enter a Gap value to add distance in between the objects
• Click Done
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After the repeat, you will have multiple instances of a single object. This means making changes
to one of the objects will also modify the others, while you can move and rotate the instances
independently.

Note:  If you have one instance selected, you can use  Edit > Select all copies  to select all instances.

5.5 Tabs

At the bottom of your Studio Toolkit window, you can see the different Tabs.

First is always the 3D tab. Next to that, a 2D tab is shown for every 2D object created in Studio
Toolkit: a Sleeve, a Label, a Bag, ...

Deleting an object will also delete the corresponding 2D tab. Different instances (created using
Repeat share the same 2D tab. In that case the 2D tab will be deleted if the last instance of the
object is removed.

You can rename any 2D tab by double clicking the name and entering the new name.

Note:  The name entered for the 2D tab will be stored as the name for the technical drawing in the
collada file, and will thus be used when importing the collada file e.g. in Studio Designer.

You can switch between the 3D tab and the 2D tab of the selected object, by choosing  View > Go
to 3D  or  View > Go to 2D , or by using its shortcut Cmd-G

5.6 Preferences

You can open the preferences by choosing  Studio Toolkit > Preferences...  (Mac) or  Edit >
Preferences...  (Windows).

In the preferences, you can set the unit to be used for Dimensions (millimeter, centimeter or inch)
and for Volumes (milliliter, centiliter or US fluid Ounce).
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